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Introducing Microsoft Office Enterprise 2007

Welcome to Microsoft® Office Enterprise 2007. The purpose of this guide is to provide you with an overview of the Office Enterprise 2007 suite and to familiarize you with the programs, features, and functionality that are unique to Office Enterprise 2007.

The New World of Work

Today’s environment for information workers is very different from five years ago. With more powerful software and computing systems, wireless connectivity, and a proliferation of mobile devices from laptop computers to smart phones to handheld devices, the definition of a workplace or team now spans locations, organizations, time zones, and cultures. An “office” now can be any place from which people create, share, and store information, and collaborate with coworkers, partners, customers, and others on projects and business processes. 
In this new world of work, where collaboration, business intelligence, and prioritizing scarce time and attention are critical factors for success, the tools that information workers use must evolve in ways that do not add new complexity for people who already feel the pressure of an "always-on" world and ever-rising expectations for productivity. 

New Challenges: Working Together, Managing Processes and Content
Teams that need to collaborate now often have a difficult time working together efficiently. We are evolving toward a diverse yet unified global market, with customers, partners, and suppliers who work together across cultures and continents. The global workforce is always on and always connected—which requires new tools to help people organize and prioritize their work.
When teams comprise individuals from multiple offices and companies, as well as mobile workers, they often must rely on a patchwork of applications, including e-mail, phone, voice mail, file shares, Web sites, and specialized collaboration tools, to work together. Each application has strengths for particular work activities, but they do not combine to provide a single, persistent, contextual work environment that is accessible to all team members—anywhere, anytime, on any network.
Also, many of these applications were designed to support only internal company work, so infrastructure costs and security risks increase when they are used for work that crosses locations and organizations. 

New Challenges: Personal Impact on Organizations
As workplace dynamics change—particularly through efforts to run organizations in as lean a manner as possible—there is substantial pressure on each individual to work more efficiently and effectively than in the past. Organizations know that improving each worker’s impact is the key to improving operational performance of the organization. However, an increasingly decentralized and mobile work environment, combined with an increase in the volume of information coming from a growing number of sources, can make it difficult for individuals to make ever more valuable contributions.
“Information overload" is becoming a serious drag on productivity—the typical information worker in North America gets 10 times as much e-mail as in 1997, and that number continues to increase. 

It's also difficult for people to find the information they need to do their jobs. Industry analysts estimate that information workers spend up to 30 percent of their working day just looking for data they need. All the time people spend tracking down information, managing and organizing documents, and making sure their teams have the data they need could be much better spent on analysis, collaboration, insight, and other work that adds value.
Microsoft Office Enterprise 2007: A Solution for Today
People are the core of any successful business, and their intelligence, their experience, and their dedication to business success are what make a business leap ahead of its competitors. The job of technology is to help people make the most of their talents and abilities. 

At Microsoft, we believe that the right technology is more than a tool; it is a lever that magnifies the efforts of employees and managers and, in the process, transforms how business gets done. Our goal is to help businesses become more agile and productive in the global economy and to empower individual workers by giving them tools that improve efficiency and enable them to focus on the highest-value work.
Office Enterprise 2007 helps people in the new world of work increase their personal impact and work together more efficiently with others by equipping them with the most complete solution for managing information overload and simplifying teamwork. Most important, the solution provides these benefits without extensive IT support, significant ramp-up time to learn new software, or advanced technical knowledge.
What Is Microsoft Office Enterprise 2007?

Office Enterprise 2007 is the most complete productivity solution Microsoft provides for people who need to create and collaborate on information in today’s digital, virtual work environment. Microsoft Office Professional Plus 2007 delivers state-of-the-art programs for prospering in the new world of work. Office Enterprise 2007 builds on the strengths of Office Professional Plus 2007 by providing two additional programs: Microsoft Office Groove® 2007 and Microsoft Office OneNote® 2007. These programs extend the value of Office Professional Plus 2007 by helping people better manage the personal information they gather and making it easier to work together with others on the documents they create and the projects they drive. 
What Is Microsoft Office Groove 2007?

Office Groove 2007 is a Microsoft Windows®–based collaboration program that helps small, focused teams work together more effectively. Office Groove 2007 helps with tasks as simple as document collaboration and as complex as developing a new product or completing a request for proposal (RFP). Teams using Office Groove 2007 work together in collaborative workspaces that place all team members, communications, tools, and information in one convenient location accessible right on each member’s computer. You can create an Office Groove 2007 workspace in minutes, add the right tools for the job to the workspace, and invite anyone to join—employees, customers, or partners—without worrying about server space or security. Because you spend less time coordinating with your team and searching for the most recent information, you have more time to work on your own contributions, which enables you to have greater impact on the organization.
What Is Microsoft Office OneNote 2007?

Office OneNote 2007 is a digital notebook that provides a flexible way to gather and organize much more than just your notes—audio and video recordings, handwritten text, Web research, screen clippings, drawings, pictures, and more can all be collected and organized in Office OneNote 2007. With your notes and information in one place, Office OneNote 2007 provides powerful search capabilities to help you find information where you couldn’t before, such as spoken words in audio and video recordings and text in scanned documents or pictures. New to Office OneNote 2007 are shared notebooks, which give teams one place to gather notes, research, and information related to a project, customer, or meeting. With shared notebooks, users can all work together—whether online or offline—and Office OneNote 2007 automatically merges and updates everyone’s changes.
In an age where we all must deal with increasing amounts of information, Office OneNote 2007 helps you keep your thoughts and your information organized so you can work more efficiently and be better prepared. Office OneNote 2007 is integrated with both Microsoft Office Outlook® 2007 and Microsoft Windows SharePoint® Services, so it’s easy to use and even easier for you to stay on top of what’s important. Office OneNote 2007 enables you to focus on your work instead of on managing and organizing your information.
How Do Office OneNote 2007 and Office Groove 2007 Work Together?
Office Groove 2007 and Office OneNote 2007 are powerful software in their own right, but when used together, they help people collaborate better and manage their information more efficiently than ever.
Office OneNote 2007 helps you to manage your notes and other unstructured information, and with it you can share notebooks with team members to collect many different types of information on a project.
Office Groove 2007 provides a place where you can take that information and work on the project. Your team can decide what tools you need in your Groove workspace to get the job done—for example, Files, Discussion, Meetings, Forms, and Pictures. The value of a Groove workspace is in its flexibility to support many types of data and connect team members inside your company and team members, customers, and partners who are outside your company.
Office Groove 2007 also gives you offline access to your documents, so that you always have the latest information and don’t have to worry about needing an Internet connection in order to be productive. OneNote shared notebooks provide a similar capability for your team’s notes that stay within the company, so that the changes you make offline are automatically replicated on others’ computers once you are back online.
What Other Applications Are in Office Enterprise 2007?

All other applications that are included in Office Professional Plus 2007 also are in Office Enterprise 2007. These include:

	Office Enterprise 2007 Program
	Benefits

	Microsoft Office Access 2007
	Organize and track complex information in a structured way, even with no coding expertise and very limited database knowledge.

	Microsoft Office Excel® 2007
	Gain insight from information using powerful analytical and visualization tools.

	Microsoft Office InfoPath® 2007
	Easily create and deploy electronic forms solutions that reduce data re-entry and improve the quality of the data collected.

	Microsoft Office Outlook 2007
	Simplify the way users locate, manage, prioritize, and act upon an increasing volume of e-mail, meetings, tasks, and contacts.

	Microsoft Office PowerPoint® 2007
	Quickly create dynamic and great-looking presentations.

	Microsoft Office Publisher 2007
	Use this complete tool to create, manage, and distribute marketing materials.

	Microsoft Office Word 2007
	Create and publish professional documents more easily than ever before.


Office Enterprise Applications: Together in Action

In the new world of work, projects often begin with an emphasis on establishing effective communication channels among busy and far-flung team members, and the real work starts with brainstorming and planning of the project. Getting everyone on the same page at this stage of the project cycle can be difficult. 

With Office OneNote 2007, a team leader can set up a shared notebook on a Windows SharePoint Services site and invite others to participate in the notebook. Brainstorming notes, minutes from meetings, and research from the Web can all be gathered in the shared notebook. A copy of the notebook is stored on each team member’s computer, so everyone has access to it whether online or offline, and Office OneNote 2007 merges their changes automatically once they are connected to the network.

When the team begins creating official project plans and documents, the project manager can create a Groove workspace that will serve as the central repository for the team’s documents, and to keep everyone constantly apprised of the latest updates to the documents. The Groove workspace gives team members access to the project documents and related information while offline, and automatically keeps team members up to date with the latest versions. Groove workspaces also securely transfer information across company firewalls, so teams can work in confidence and in context with others from outside their organization.
Using the programs available in Office Enterprise 2007, a team can get established and begin work more efficiently than they ever have.

For more information about Microsoft Office Enterprise 2007, please visit www.microsoft.com/office/preview/suites/enterprise/.
For more information about the 2007 Microsoft Office system, please visit http://www.microsoft.com/office/preview.
Office Groove 2007 Guide
Today’s workplaces and work teams span departments, offices, organizations, time zones, and cultures. While this fluidity has its advantages, such as organizations’ ability to quickly respond to business opportunities, it also creates coordination challenges. Teams that do not share a common office network, or that are simply working away from their own office, often are forced to rely on e-mail, phone calls, and teleconferences or in-person meetings to work together and communicate critical project updates. 

Office Groove 2007 can help your team work together more efficiently by bringing all team members, tools, and information together in one place—right on your computer.

Office Groove 2007 Features
Here is a brief summary of a few of the Office Groove 2007 features that can help you and your team work together more efficiently and effectively:

Features to Simplify Working Together

	Office Groove 2007 Features
	Benefits

	Collaborative workspaces
	Workspaces are easy to create and securely connect team members with enhanced security regardless of location. Users can invite other team members to the workspace without IT assistance.

	Integration with Microsoft Office Communicator 2005 and 2007
	You can view Communicator contacts, see their awareness state, and initiate instant messaging sessions, right from Office Groove 2007.

	Document collaboration
	Everyone on your team can work together on any type of computer file, with a familiar folder organizational structure.

	Threaded discussions
	This enables everybody on your team to track and contribute to a shared, ongoing conversation on important topics. 

	Meeting and calendar tools
	Help keep everybody on your team apprised of important project milestones, meetings, and updates.

	Workspace chat
	Have impromptu, spontaneous discussions with team members, right inside a workspace.


Features for Managing Content

	Office Groove 2007 Features
	Benefits

	SharePoint integration
	The process of syncing SharePoint document libraries with Groove workspaces is easy and efficient, and you can publish files from Groove workspaces to SharePoint document libraries for organizational retention of information.

	Structured data collection
	Collect and track structured information among your team using customized Office InfoPath 2007 forms or Office Groove 2007 forms.


Features to Increase Personal Effectiveness

	Office Groove 2007 Features
	Benefits

	Automatic synchronization 


	Work online or offline without having to upload, download, or e-mail documents or information.

	Alerts
	Alerts let you know instantly when files and information change in your workspaces and when team members perform important activities.

	Presence awareness

	Figure out who is working on what, when, so you can engage team members just at the right time.

	Support for multiple computers
	Keep copies of key project files and information in sync across your laptop and desktop computers automatically.


Getting Started

The first thing you see when you start Office Groove 2007 is the Launchbar. This easy-to-use tool helps you manage and organize all your Groove activities, including creating new workspaces, inviting others to workspaces, sending messages, monitoring workspace and contact activity, and setting your personal Groove preferences.

The Launchbar includes two task panes, one for creating and managing your workspaces, and the other for adding and managing your Groove contacts. The panes can be viewed side by side or vertically. Both include a Common Tasks list that you can use to quickly access commonly used functions. 
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Figure 1: The Groove Launchbar

Create a Collaborative Workspace 

In Office Groove 2007, a workspace is a virtual place where teams collaboratively share, modify, and discuss files; chat; hold threaded discussions; manage recurring project meetings; create custom tools to track tasks, opportunities, and issues; and more. Workspaces also can offer any of a number of available tools. For example, a workspace used to coordinate a new product launch might have a Files tool to develop the various marketing materials; a Discussion tool for posting questions, brainstorming ideas, and tracking new developments; a Meetings tool to manage the agenda, minutes, and action items from each weekly meeting leading up to the launch; and a Forms tool to track press opportunities and advertising placements.
Each Groove workspace is an individual window that is opened and closed from the Launchbar as needed. Office Groove 2007 users typically have many workspaces, one for each of the various projects they work on or teams they work with. A workspace may last a day, a week, or several months. 
Any user who has Office Groove 2007 installed on his or her computer can create a workspace. It does not require any special privileges on the network or extensive IT support. In fact, the process is so simple that you can create and customize a Groove workspace for your team with just a few clicks of your mouse.
Office Groove 2007 includes three types of workspaces:

· A standard workspace includes a Files tool and a Discussion tool. Additional tools can be added to a standard workspace to meet changing project needs.

· A file sharing workspace synchronizes a selected Windows file folder and its files across team members’ computers. This type of workspace can be particularly useful for individuals who want to keep files synchronized across their own computers. For more information, see the Keep Yourself In Sync section of this guide. 

· A template enables you to choose from a list of pre-customized workspace templates designed for a specific type of project need. In the future, you will be able to connect to Office Online and access additional Groove workspace templates tailored for particular business functions and markets. You can also create templates from your own workspaces for future use. For more information, see the Customize Your Workspaces section of this guide.
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Figure 2: The Groove “Create New Workspace” Wizard

Invite Team Members to Join Your Workspace 

After you create a workspace, you manually invite your team members, one by one. In this way, you are in complete control over who has access to the workspace and the data contained within it. Only those whom you invite to the workspace can access the information it contains. There is no “master copy” on a server.
Invitations can be sent via e-mail or directly in a Groove message. To accept your invitation, each team member must have Office Groove 2007 installed on his or her computer. Those who do not have Office Groove 2007 installed will receive the invitation through e-mail. E-mail invitations contain simple instructions on how to download a trial version of Office Groove 2007. Once they install the trial version, they can then accept the workspace invitation.

For each team member you invite, you can assign a Role (Manager, Participant, or Guest) to help control what he or she can and cannot do within the workspace. Roles and their associated permissions can be changed at any time. When invitees accept your invitation, they download an exact copy of the workspace onto their desktops, including all files and content. If you are not online when they accept, Groove sends the workspace to the new members’ computers the next time you connect; or, if there are other online workspace members, they get the workspace from them. Once the invitees are in the workspace, you can begin to work together in context. It is that simple.

The beauty of Office Groove 2007 is that you can invite anybody to join your workspace, even if they are not on the same network as you. You can share a workspace across offices with remote colleagues and across organizations with your partners, suppliers, and even your customers—all without servers or IT assistance. And you don’t have to worry about the security of the information in your workspaces. Office Groove 2007 has powerful, built-in encryption to help ensure that all workspace data has enhanced protection as it travels across unsecured wired or wireless networks. Furthermore, Office Groove 2007 encrypts standard and template-based workspaces directly on your computer, so it provides an additional layer of protection in case your laptop is lost or stolen.
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Figure 3: Sending an invitation in Office Groove 2007

Add Tools to Suit Your Team’s Evolving Needs

Office Groove 2007 is very flexible, so you can create a workspace tailored to the specific needs of each of your teams. You can customize the workspace at any time by adding or removing tools from it. Tools define the type of work your team does in the workspace.

Though Office Groove 2007 includes more than 10 out-of-the-box workspace tools, the following five tools are the most popular:

Files Tool

You can use the Files Tool to work collaboratively with your teammates on almost any type of computer file. The Files Tool works similarly to Windows Explorer in that you can organize files into nested folders. One of the differences between Windows Explorer and the Groove Files Tool, though, is that everybody in your workspace has access to those folders and files. 

When you add a file to the Groove Files Tool, any person you have invited to the workspace can open that file. Depending on the role they are assigned in the workspace, they can also make and save changes to it. After a person modifies a file, they can save it back to workspace and choose to overwrite the existing file or save it as a new file. If two members happen to update a file at the same time, Groove creates two copies of the file for the users to resolve or merge. 

SharePoint Files Tool

The SharePoint Files Tool offers all the capabilities of the Files Tool with the added benefit of integration with SharePoint document libraries. Many teams and departments rely 
on SharePoint technologies to organize, share, and publish information and documents.
The SharePoint Files Tool in Office Groove 2007 is tightly integrated with both Windows SharePoint Services (version 3) and Microsoft Office SharePoint Server 2007, so you and your team can synchronize SharePoint document libraries with your Groove workspace. You can easily check out documents from a SharePoint document library into your Groove workspace and collaborate on and iterate those documents among your project team. When you’re done, you can then check the documents back into the SharePoint document library, create an approval workflow among a larger group, or simply store them for others to access.
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Figure 4: The Groove SharePoint Files Tool

Discussion Tool
The Groove Discussion Tool enables teams to engage in a detailed exchange of ideas in context of the work they are doing in the workspace. The conversational thread is tracked in a chronological, topic/response structure. Anybody in the workspace can contribute to the discussion or review the entire thread. Roles determine who can delete Discussion entries. 


Figure 5: The Groove Discussion Tool

Meetings Tool

Use the Groove Meetings Tool to plan, conduct, and record recurring team project meetings. It is easy to set up a new meeting and select workspace participants using the Meetings Wizard. Because all workspace members can add information to a new meeting, agendas can be developed collaboratively rather than having one person collect input from the team. During the meeting, the minutes-taker can insert the agenda into a note-taking space and record meeting minutes in real time. Participants can watch as the minutes are taken. After the meeting, action items can be recorded and assigned to team members. Agenda items, minutes, and action items from prior meetings can also be copied into future meetings.

Calendar Tool

You can use the Calendar Tool to build a shared project schedule and track important project dates and milestones. When you add a Calendar event, everybody on your team can see it. Others can add their own events and edit existing events if they have the appropriate permissions. 

Both the Meeting and Calendar tools enable participants to focus solely on the tasks, events, and milestones of the project or activity for which the Groove workspace is created. Individual team members continue to manage and organize their own calendars, tasks, and contacts in Microsoft Office Outlook 2007 messaging and collaboration client or another personal information manager.
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Figure 6: The Groove Calendar Tool

Stay In Sync Automatically and Efficiently

During the course of a team project that spans weeks or months, the manual steps required just to share and collaborate on files and coordinate changes among team members can consume hours or days of productivity—time that is taken away from content creation and improvement. When team members are offline, productivity is reduced even further. Slow connections and e-mail file size restrictions make it difficult to share large files. Links to Web sites in e-mail may not always work for partners or off-site employees. File versions proliferate. And, perhaps worst of all, team members lack a shared context for all changes, input, and comments since they are spread across dozens of e-mail threads, file attachments, file shares, and Web sites.

Office Groove 2007 helps alleviate the pain associated with keeping teams aligned by synchronizing or pushing changes to ongoing work—automatically and efficiently—rather than forcing each team member to send or upload their individual updates. Because teams spend less time coordinating with each other, they have more time to spend on their team work, enhancing the quality of deliverables.
Let’s explore in more detail how Groove synchronization works. 

Keep Your Team In Sync

Office Groove 2007 has a unique decentralized architecture that helps streamline team collaboration. Every team member has an exact copy of the workspace, tools, and data right on their desktop. The automatic and efficient synchronization of Office Groove 2007 helps ensure that each person’s copy stays up-to-date—even if no two members are online at the same time.

Work Effortlessly Anywhere—Online or Offline 

Office Groove 2007 stores workspaces and the data they contain right on your computer, not on a central server. This enables you to access and update the information in your workspaces whether you are connected to the network or not. Each time you make a change—update a file, respond to a discussion, or post some text in the workspace chat area, Office Groove 2007 pushes your change—and just the change—to all the members of your workspace. If you are not online when you make the change, Office Groove 2007 sends it the next time you connect. If your team members are not connected, they will receive the change the next time they connect. 

Getting Used to Synchronization

Because Groove synchronization operates constantly in the background, it is best to connect to either your corporate network or the Internet as often as possible while running Groove. This keeps you and your team members up to date on workspace activity and changes. It’s similar to keeping your e-mail program up and running all day to monitor incoming messages.
While synchronization saves you time, it takes a few moments to receive updates the first time you connect after being offline for a period of time. Startup synchronization time depends on several factors, including how many workspaces you have, how many team members are in each workspace, how many changes were made since you last connected, and the speed of your connection. 

If you are working on a slow connection, or are frequently on the road, automatic synchronization may not always be practical. With Office Groove 2007, you have the power to decide the most productive setup for your work style. 

Because files are among the largest types of data shared among a team, you can adjust the Download Settings in your Groove Files Tool, SharePoint Files Tool, and file sharing workspaces. Download settings enable you to determine which files are automatically synchronized and which ones you want to download manually from your team members. 

If you want to stop all incoming information, you can choose to work offline right from the Groove icon in the Windows taskbar. Alternatively, you can selectively decide which workspaces to synchronize or Pause All communications by using the Communications Manager feature in Office Groove 2007. Just remember to Resume All communications for your workspaces and deselect the Work Offline feature when you regain a fast connection.

Keep Yourself In Sync

Like many information workers, you might use more than one computer (such as a home computer and a work computer) in your day-to-day work. It’s just not efficient to spend your time sending files to yourself via e-mail or copying them to storage media each time you switch from one computer to another. In addition to helping teams stay in sync, Groove synchronization can also help you keep important files and workspaces up to date across the computers you use on a daily basis. 

When you configure your Groove account to run on multiple computers—a desktop and laptop, for example—Office Groove 2007 automatically synchronizes your workspace folders on each computer you use. Your computers never have to be online at the same time to stay in sync, as long as each one is running Office Groove 2007. Additionally, you can use the Groove Folder Sync feature to synchronize specific Windows folders across your computers. Any files in these folders will remain synchronized across your computers.
Monitor Team Activity and Communicate in Real Time

Many teams struggle to coordinate who is working on what, when. A weekly status meeting simply is not sufficient to address the minute-to-minute, hour-to-hour, and day-to-day changes that occur as team work progresses. Office Groove 2007 includes a number of features to help you and your team members monitor team activity (such as file updates) all the time, so you can spend less time coordinating and more time working. In addition, Office Groove 2007 provides a robust set of real-time communication tools and options to support both the spontaneous and deliberate team interactions that are so critical to project success. 

Presence Awareness and Alerts 

Office Groove 2007 includes built-in presence awareness and alerts, so you can figure out who is working on what, even if they are in another department, office, organization, or country.

Presence tells you which members are currently active in a workspace, which are online but not actively working in a workspace, and which are offline. Just by viewing your Launchbar, or opening a specific workspace, you can scan your contacts’ presence and gain awareness of work activity, without having to ask. In addition, if your team members are running Office Communicator 2005 or 2007, hovering over a contact reveals their current awareness state. 

Alerts are text pop-up windows and audible sounds that proactively let you know when activity occurs in Groove. As you work, Office Groove 2007 may display or sound an alert:

· To notify you of any new information in a workspace.

· To notify you of new information in a particular workspace tool.

· To notify you of changes to a specific file folder or file.

· To notify you when contacts come online or enter workspaces.

· To notify you about new instant messages or invitations.

· To track the status of workspace invitations and messages you have sent or received.

Alerts that notify you of content changes are persistent and contextual. You can click them at any time, even if you are offline, and Office Groove 2007 takes you right to the content item that has changed. 

You do not have to do anything to receive basic workspace alerts— Office Groove 2007 automatically determines the workspaces you use most and alerts you accordingly. But the real power of Groove Alerts is that you can “tune” them according to which contacts, workspaces, tools, and files are most important at any given time. 
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Figure 7: Groove Presence Awareness and Alerts

Unread Marks

While alerts notify you when changes are made inside your workspaces, Unread marks help you find the specific content in a workspace that you have not yet seen. In your Launchbar, workspaces with unread content are marked with Unread marks of varying levels of boldness, indicating how recently the changes were made. 

Within workspaces, Unread marks appear on the Tool tabs, as well as on the specific items that have new content such as a file or discussion thread. As soon as you read the new content, the Unread marks are removed automatically. You can also manually remove all Unread marks in a Tool or workspace. 

Real-Time Communication Tools

Everybody knows that frequent team communication is critical to the successful completion of most projects. Without that communication, important issues often go unaddressed, leading to a delay in delivery or, worse yet, a misunderstanding about the final project deliverable. Yet teams in the new world of work often do not have the benefit of those spontaneous hallway conversations where so much valuable information can be exchanged.

Office Groove 2007 provides teams with integrated real-time communication tools to facilitate both deliberate and spontaneous information exchange. Office Groove 2007 supports multiple modes of real-time communication to help your team make better, more informed decisions and shorten overall project cycles.

Microsoft Office Communicator Integration

With Office Groove 2007, you can now take advantage of the powerful and robust real-time communications capabilities of Office Communicator directly from Groove. When you are running Groove 2007 and Office Communicator 2005 or 2007, you can view the awareness states (online, busy, or away, for example) of your Communicator contacts directly from the Groove Launchbar or a Groove workspace. When a contact is free, a simple right-click enables you to initiate a Communicator real-time chat or phone call with that contact directly from the Groove interface. 

Workspace Chat

Workspace Chat in Office Groove 2007 enables team members to communicate in real time in the context of a particular workspace. Workspace presence awareness helps you figure out the right time to engage a team member, and workspace Chat enables you to do so at just the right time. You can communicate in workspace Chat using text or voice, depending on your needs. Voice messages are only sent to members who are actively working in the workspace. Text chats, on the other hand, are sent to all members, who receive a flashing alert indicating that someone is attempting to communicate with members of that workspace. Clicking the alert brings them into the workspace Chat with you. 

Messaging

While Office Communicator is the ideal tool for real-time messaging, Office Groove 2007 includes a basic messaging capability that can be valuable if you’re working offline and want to send a quick text or voice message. You can send a message to a team member from the Launchbar or right from a workspace. Links to workspace content can be embedded in the text of messages, helping draw the message recipient’s attention to a particular work item. New messages appear in your system tray with your other Groove alerts.

Customize Your Workspaces

From the beginning, Office Groove 2007 was designed to help people quickly and effectively work together. For some teams, that just means having a workspace where they can share files or engage in team discussions. Other teams, however, may require more business process–specific tools for collaboration. Power users can use the Groove Forms Tool and Groove InfoPath Forms Tool to build custom workspace tools that meet their unique needs. 

Build Custom Forms

The Groove Forms Tool brings your structured data and business processes right into the Groove environment. Your team can build custom Forms Tools to enter and update data, get detailed information on the status of work items, and represent simple workflows. A development team may want to create a Groove form to track incidents or bugs, for example, while a sales team might create a Groove form to share information on customers, prospects, and sales calls. 

You can build custom forms directly in the Groove interface using the Groove 2007 Forms Tool Designer. The Forms Designer is a rich and flexible environment that enables any workspace member with the necessary permissions to contribute to the design of the application. Like most Web page design tools, the Forms Designer enables you create and make changes to a form and then preview it before you publish your changes to the workspace. 

Import an Office InfoPath 2007 Form
Office Groove 2007 also includes an option for you to import a pre-existing form that you build with Office InfoPath 2007. Office InfoPath 2007 provides an intuitive development environment with all the components you need to build a new form or modify an existing one. Once you have built your form in Office InfoPath 2007, you can use the Groove InfoPath Forms tool to import the form into the workspace. Once imported, team members can fill out the form to track issues relevant to the project at hand.


Figure 8: An Office InfoPath 2007 form in a Groove workspace

Create Templates for Future Use

Most teams often complete similar projects over time—a product launch or new business engagement, for example. Often it is helpful to use a workspace that has been preconfigured for these projects. Once you have created a workspace for a specific project, you can save it—or any custom tools within it—as a template for future use. Your tool templates automatically appear in the Groove Add Tool list, while your workspace templates appear in the Custom Workspace list.

Summary

In today’s increasingly global and mobile work environment, workers in diverse locations, organizations, and time zones need tools that enable them to collaborate easily with their team members—wherever they are in the world. 

Office Groove 2007 is an easy-to-use collaboration program that enables teams in this new environment to work together easily and purposefully toward their goals and deliverables. Teams using Office Groove 2007 share collaborative workspaces that place all team members, communications, tools, and information in one convenient location, accessible right on each member’s computer. While you may not be able to stop by your coworker’s office to hand her a document and chat about your project, with Office Groove 2007 you can share the same valuable information and collaborate in that same spontaneous manner.

Office OneNote 2007 Guide
In today’s world of work people are increasingly required to stay on top of ever-growing volumes of information, and teams are being asked to work together in new ways and more than ever before. People have lacked a tool that’s flexible enough to capture the many different types of information that they must deal with every day, and organizations lose valuable information because it isn’t captured or because it’s lost in e-mail. When tasked with working together, teams default to e-mail for information sharing and collaboration, and it’s increasingly difficult to get teams “on the same page.”

Enter Microsoft Office OneNote 2007, a digital notebook that gives you the flexibility to gather virtually any type of information—from typed text, audio, and video to handwritten notes and drawings, technical graphics, and research from the Web and other applications—all in one place. Powerful search capabilities enable you to easily find information you couldn’t before, such as spoken words in audio and video recordings and text in scanned documents or pictures. Shared notebooks give teams a place to work together and automatically merge and update people’s contributions, whether their changes were made while online or offline.

Now you can work more efficiently and find what you need more quickly, using the digital notebook capabilities Office OneNote 2007 provides for gathering, organizing, and sharing your notes and other information.

Office OneNote 2007 Features
Office OneNote 2007 includes a range of enhancements that make it easier than ever to find, gather, and work together on information. You can now more quickly find the content you need, and you can easily search for information in multiple types of content. Also, Office OneNote 2007 offers stronger integration with other Office programs, such as Office Outlook 2007 and Windows SharePoint Services, and enables closer collaboration among team members. You also now have more control over your information— Office OneNote 2007 supports multiple notebooks, which enables users to distinguish between their personal notebooks and shared, team notebooks.

Features to Simplify Working Together

	Office OneNote 2007 Features
	Benefits

	Support for multiple notebooks 
	Multiple notebooks enable people to remain in control of their information, and enable organizations to set up shared notebooks for projects, recurring meetings, or other team work.

	Enhanced notebook sharing
	Shared notebooks give teams one place to collect project and team notes and other content. Team members can work simultaneously in a shared notebook, or at different times from different locations; updates happen automatically across all team members’ notebooks.

	Offline read/write access to shared notebooks
	People can make changes to shared notebooks while offline; changes merge automatically once reconnected.

	Ability to store shared notebooks on Windows SharePoint Services sites
	Shared notebooks stored on Windows SharePoint Services sites enable organizations to digitize, store, and archive new types of content, because the contents of OneNote notebooks are searchable on Windows SharePoint Services


Features to Increase Personal Effectiveness

	Office OneNote 2007 Features
	Benefits

	Enhanced integration with Office Outlook 2007
	Two-way task synchronization between Office OneNote 2007 and Office Outlook 2007and the ability to take notes in OneNote on any Outlook item make it easy to keep track of action items and other important information.

	Improved integration with Windows Mobile®–powered devices
	Be more productive while mobile by taking notes, gathering information (including pictures from your camera phone), and viewing your notes while away from your computer on your Windows Mobile–powered device.

	Enhanced integration with Office Communicator
	Take notes on an Office Communicator conversation quickly and easily.

	Gather many types of content in Office OneNote 2007
	Make more informed decisions by gathering all of your unstructured info in one place—Office OneNote 2007 enables you to print anything to your notebook, send Web pages to OneNote from Microsoft Internet Explorer, embed Microsoft Office documents and e-mail messages in OneNote notebooks, and record audio and video.


Features for Managing Content

	Office OneNote 2007 Features
	Benefits

	Instant Search
	Find what you are looking for quickly by using Instant Search, which capitalizes on the Windows Desktop Search engine and indexes your content for you in the background.

	Optical Character Recognition (OCR) search
	The OneNote OCR engine reads text in scanned documents, pictures, or images, enabling you to find information where you never could before.

	Audio search
	Save time finding relevant information by searching for spoken words in audio and video recordings.

	New organization pane
	Organize your information according to your needs and keep your information at your fingertips by using the new organization pane, which supports drag-and-drop functionality and hyperlinks between sections of your notebook.

	Import/export application programming interfaces (APIs)
	Reduce errors and avoid entering the same data in multiple systems by enabling Office OneNote 2007 to connect directly to the other systems you use, such as CRM and document management systems. 


Getting Started with Office OneNote 2007
Getting started with Office OneNote 2007 is as easy as opening the program and beginning to type anywhere on the page. Unlike Office Word 2007 or other document processing applications, Office OneNote 2007 offers you the flexibility of typing wherever you want—as you would with a pen and paper notebook. And, as with pen and paper, there is no Save button in Office OneNote 2007—everything is automatically saved as you write it. Even if you turn off the computer or close the program quickly, you do not need to worry about losing important information—it is already saved. Office OneNote 2007 also automatically creates backups of your notebooks, giving you peace of mind.
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Figure 9: An Office OneNote 2007 page
Anatomy of a OneNote Notebook

Office OneNote 2007 is structured much like a paper notebook, with individual pages, tabs, and sections for organizing different categories of information within your projects.
You can click anywhere on the Office OneNote 2007 page surface and begin to write, draw, or record information. But what is a OneNote page, and what are its key features? Let’s look at the distinction between OneNote pages and sections, which are simply different kinds of containers for organizing information. 

[image: image8.png]J Nov 2005 - Microsoft Office OneNote

Fle Edt Yew Insert Fomat share Window Heb | A
{@eek - @ e -+ 5§ H A4 A9 e[ v - 0] @ 1% s v
e —— - Fabrikam Journal Review 2

November 2005

Mondsy, Nobember 15t 2005
514941
November 2005

<4=m= OneNote
N k:
otebooks OneNote
Section Tabs

5 rescoren (B peronat [ Wk

B
i





Figure 10: An Office OneNote 2007 page
An Office OneNote 2007 notebook contains one or more sections; sections contain one or more pages. Sections appear as colored tabs on the top portion of the Office OneNote 2007 page surface. The pages in a given section appear as tabs along the vertical axis of the OneNote page surface. You can add an unlimited amount of pages to any OneNote section, so you’ll never run out of “paper” in your notebook. 

Notebook Section Tabs

Near the top of the OneNote page are tabs representing the sections within a notebook, which are much like sections in a three-ring binder. You can create as many sections as you need and customize them by naming them after different projects, types of meetings, or anything you want. For example, project managers might have a different notebook for each project, with different sections for each component of a project (such as vendor meetings, client meetings, and project timelines).

Gathering Your Notes and Information in Office OneNote 2007
Most people don’t have a single place where they can capture all the different pieces of information that they use in the course of their work. Some information resides in e-mail messages, some is stored on Web sites, and some details might be in a video presentation or on a pad of paper. Wouldn’t it be great if you could bring together, in one place, all the ideas and the meeting notes, the Web research, and everything else that you need to do your work? 
That is what Office OneNote 2007 is all about: giving you the ability to gather, organize, and integrate in one virtual notebook of all the information that your work requires. 
Creating a New Notebook

You create a new notebook simply by selecting File > New Notebook from the OneNote menu bar. 
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Figure 11: Create a new notebook using the New Notebook Wizard 
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Figure 12: The New Notebook Wizard

Typing Text into Office OneNote 2007
When you take notes using a pen and paper, you can place your pen anywhere on the page and just start writing. Office OneNote 2007 provides the same flexibility. Simply click anywhere on the OneNote page surface and you can start capturing your ideas.

With Office OneNote 2007, you can easily group related matters. For example, before a meeting you might create an area for notes (a “container”) titled Agenda, a second area titled Attendees, and a third titled To Do, with a table to capture action items. During the meeting, you can quickly add relevant information to any of those three areas—or click somewhere else on the page to start a completely new thought.
Managing Containers of Content

You can even move whole note containers by clicking a container’s outline—visible when the cursor hovers over it—and dragging it elsewhere on the page. By dragging one container into another, you can combine the content from both containers into one. Similarly, by selecting some of the content of a container and dragging it away from that container’s outline, you can split one container into two. You can also cut or copy a container and paste it on another page altogether.
If you want to work with a portion of content, you can use the Lasso tool in Office OneNote 2007 to draw an outline of any shape around text, a drawing, or any other type of content, and then you can cut, paste, or move that content.
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Figure 13: The Lasso tool
Printing Information into Office OneNote 2007
Office OneNote 2007 has a print driver that enables you to print any document to OneNote just as you would to a printer. With this feature, you can save any document as an image that you can annotate. 
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Figure 14: Printing a document to Office OneNote 2007
Sending Information to Office OneNote 2007 from Other Office Programs

You can paste into Office OneNote 2007 virtually anything that can be captured using the standard cut-and-paste features of the Windows operating system. For example, Office Outlook 2007 has a Send to OneNote button for calendar items and contacts, and Office Communicator 2007 has a Take Notes button in the Communicator window. You can also paste hyperlinks to other files and Web sites into a OneNote notebook. 
Embedding Office Files and E-mail Messages into Office OneNote 2007
In addition to the ability to cut and paste between Microsoft Office programs, you can use Office OneNote 2007 to embed files into a OneNote notebook. You can drag any file from Windows onto a OneNote page, or you can insert the file into the page by going to the Insert menu and clicking File. If you are managing a big project, you are likely to use different types of documents to track pieces of the project. Now you can keep these documents in Office OneNote 2007 together with everything else.

Gathering Web Research into Office OneNote 2007
OneNote 2007 offers several features that help you conduct research more efficiently by capturing all of the Web-based information you need in one place. For example, with the Side Note feature you can drag research into a OneNote notebook as you’re working in a browser. (Hint: Right-click the OneNote icon in your system tray, and click Open New Side Note, or simply type the Windows logo key+ n on your keyboard.) The Screen Clippings feature enables you to select portions of Web pages or other content on your screen and automatically paste them into Office OneNote 2007. (Hint: Right-click the OneNote icon in your system tray, and click Create Screen Clipping, or simply type the Windows logo key + s on your keyboard.) The Send to OneNote button in Internet Explorer enables you to send Web pages with a mouse click. And, of course, you can just copy and paste. When you copy and paste information from a Web site into a OneNote page, the source URL is automatically inserted with the information, so you can click the link and quickly return to the source of the information. 

Capturing Information on Your Windows Mobile–Powered Device

Office OneNote 2007 makes it easier than ever to integrate your Windows Mobile-based Smartphone or Pocket PC into your information-gathering toolset. You can copy portions of your OneNote notebook onto your device so you have the information you need when you are only carrying the device. You can capture new information on your Smartphone or Pocket PC and easily integrate it into your OneNote notebook. In addition, pictures taken with the camera on your Smartphone can be integrated into your OneNote notebook, and provided the quality of the image is high enough, any text in the picture will become part of its searchable content. You can also use the microphone on your device to record voice notes and integrate them into your OneNote notebook.
Inserting Images into Your Notebook
Any printable document can be inserted as a color image into your OneNote notebook. For example, you can insert a résumé into OneNote prior to an interview, or an PowerPoint presentation prior to a meeting. By inserting the file into your notebook, you can annotate it and save both types of information in the same place. 
 [image: image13.png]¥ Product Description Final Document - Microsoft Office OneNote

Bl Edt Uew Iwet Fomet hare Wndow Hep | A

@peck - @ - tew - 5 H 34 A9 o- @ v 0@ 1

Marketing Documents = = L search

] NewPage ~
Product Description Final Document Product larring

Monday, Noverber 15t 2005 Sales Plan
10:038M

Sales Forecast

Market Research

Campaigns
Product Descriptio

To Do ltems.

Fabrikam Journal ..u.zws

Organizational Realignment

World-wide. The new executive leadership
streamline each of our regional operations to

Vice President

North America  Arlene Huff Dallas, TX
Sean Purcell Vancouver, Bc
Joe Healy Kyoto

- = Erik Andersen Hannover

allow our global enterprise to Martin Bankov Milan

optimize our inventory, sales Rob Barker Galway

management and capital investments to grow the business. Thisis part of the ongoing

effort of the Fabrikam Corporation to demonstrate leadership, flexibility and prowess in

the widget industry.





Figure 15: Inserting a printable document as a color image

Handwriting and Office OneNote 2007
If you have a Tablet PC or a pen input device, you can use your digital pen to take handwritten notes or draw pictures and diagrams in Office OneNote 2007. If you are using a Tablet PC, you can either convert your handwriting to text or leave it as handwriting. And because Office OneNote 2007 takes advantage of the new Tablet PC Ink parser, the inking experience in Office OneNote 2007 is better than ever.
The OneNote search engine treats handwriting entered on a Tablet PC the same as text. You can use the search capabilities of Office OneNote 2007 to find information entered as handwriting or text, and Office OneNote 2007 finds the entry either way. 
Creating a Drawing in OneNote

Office OneNote 2007 offers a drawing tool so you can create drawings on a notebook page, even if you don’t have a Tablet PC.
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Figure 16: OneNote drawing tools
Recording Audio and Video
Office OneNote 2007 takes information gathering beyond the traditional boundaries of text and graphics by enabling you to record linked audio and video notes. Audio and video notes are particularly valuable when you do not want to miss anything that someone says or does. You can also use the Search feature to quickly find specific words or phrases in the spoken words in recorded audio or video.
 (See Finding Your Information below.)
Recording Audio
If you have a microphone connected to or built into your computer, you can record audio by clicking Insert and then Audio Recording. This will start the audio recording, and expose the toolbar so you can stop and play back the recording. Office OneNote 2007 identifies when the audio recording starts, and—as you make notes on the page—it synchronizes what you have written with the audio. By doing this, Office OneNote 2007 tracks the audio that occurred at the exact moment each note was typed or written. 

Later, if you need to clarify a certain note, simply move your mouse cursor over the text in question. An icon of a speaker appears in the margin. Click this icon, and Office OneNote 2007 plays the audio that it recorded while you were writing that line in your notebook. You can also listen to the entire audio by clicking the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video Recording toolbar. If the See Playback button is selected in the Audio and Video Recording toolbar, Office OneNote 2007 highlights what you have written as the audio progresses. If you connect your computer to your phone using an inexpensive adaptor, you can record conference calls and link your notes to that audio as well.

Recording Video

If you have a digital video camcorder or webcam attached to your computer, you can record video (and audio, if you have a microphone) by clicking Insert and then Video Recording. The same recording toolbar as before controls playback and stopping the recording. Office OneNote 2007 captures the time and date when the video recording starts, and it synchronizes any annotations you make with the video. If you need to clarify something you have written, you can hover your mouse cursor over the text in question, and an icon of a speaker appears. Click the icon, then Office OneNote 2007 replays the video recorded when the annotation was made. You can also replay the entire video by clicking the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video Recording toolbar. If the See Playback button is selected in the Audio and Video Recording toolbar, OneNote then highlights what you have written as the video progresses.

Organizing, Finding, and Managing Your Information 
Navigation Pane and Support for Drag-and-Drop Organization
Office OneNote 2007 features a new navigation pane that makes it easy to organize and navigate Office OneNote 2007. The navigation pane is similar in look, feel, and behavior to the new navigation pane in Office Outlook 2007, and can be collapsed or expanded according to your needs. By clicking a notebook icon, you can easily move between open notebooks. Across the top of the OneNote workspace you still see the familiar tabs associated with notebook sections.

By clicking the arrow at the top of the navigation pane, you can expand the view to show more detail about the notebooks and embedded sections. You can click a section in a notebook and jump to that section, making navigation across multiple notebooks and sections much easier.

Office OneNote 2007 incorporates an intuitive drag-and-drop interface, which you can use to reorganize your notebooks, sections, and pages quickly. For example, you can click and hold a section tab and then drag it to another location among the section tabs. 

Staying in Control of Your Information

Because Office OneNote 2007 supports multiple notebooks, you can determine which notebooks to share and which to keep private. You share only what you want with whom you want.
You can help protect sensitive sections of your notebook with passwords. Using Office OneNote 2007 section protection encrypts those sections. When you try to access a protected section, you must first enter your password to view the page contents. 

Office OneNote 2007 saves your password in memory so that you do not have to re-enter it every time you go back to the section. If you leave Office OneNote 2007 for more than a specified period (the default period is 10 minutes, but you can configure this in OneNote Preferences), Office OneNote 2007 relocks protected sections, and you must enter your password to open those sections.

Hyperlinks
Now you can insert links and jump between OneNote pages—in the same notebook or in other notebooks. In fact, you can now create hyperlinks to any location or document from within OneNote. You can also create links to OneNote pages from any other document or location. 
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Figure 17: Embedding hyperlinks in Office OneNote 2007

Office OneNote 2007 supports links to specific portions of other documents, presentations, and Web pages. You can also insert links to individual contacts, e-mail messages, and calendar items in Office Outlook 2007, thus creating a strong web of connections between all the people, places, and events that you need to do your work.
Finding Your Information

Instant Search makes it possible for you to search through all of the content in your OneNote notebooks so you can find the information you need faster than ever.
With new and powerful integrated Instant Search, you can quickly locate the information you need, whether it’s text in Web clippings, images, or scanned documents, spoken words in audio recordings, or other information across all of your OneNote notebooks. Type in a keyword, and Instant Search quickly searches your OneNote data, highlighting the locations where that search term appears. 
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Figure 18: Searching for a word or phrase in any OneNote notebook content

Instant Search can search broadly across all your OneNote notebooks, or you can specify a search within a particular section, section group, or a particular notebook. Instant Search uses the Windows Desktop Search engine, so that you have a common search experience across Windows, Office OneNote 2007, and other Microsoft Office programs such as Office Outlook 2007. It indexes your content automatically in the background, including scanning pictures for text using the Optical Character Recognition (OCR) engine in Office OneNote 2007, so you can find what you’re looking for quickly.
Optical Character Recognition Search
While Office OneNote 2007 treats these imported graphics and imported file printouts as images, it also includes an OCR engine that automatically scans each image for text. If the OCR engine finds text within an image, it associates that text with that image and caches that text in the search index. In this way, the content in inserted images, whether they are CAD files with part names, Web pages pulled from the Internet, or any other kind of printout, become searchable. If you insert a photograph of a business card and then prompt Office OneNote 2007 to search for the company name appearing on the business card, a link to the image of the business card appears in the search results pane. 
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Figure 19: Searching for a word or phrase in any OneNote notebook content

Audio and Video Search

In addition to finding text in graphic images, Office OneNote 2007 can find text within audio and video files. Office OneNote 2007 relies on sophisticated speech-to-text tools and attempts to analyze audio and video files for recognizable content. For example, if you record a webcast that includes a discussion of the Astrodome, a search for references to the Astrodome would deliver a link to the audio file in which the Astrodome was discussed. If you click the link in the search results window, Office OneNote 2007 opens the page with the embedded audio file and begins playing the recording at the point where the Astrodome came into the discussion.

Managing your information

Note Flags

Office OneNote 2007 offers a set of Note Flags that can be used to mark key items, urgent notes, or notes that require follow-up. You can customize icons and names for your Note Flags, apply any combination of font color and highlighting to a Note Flag, and add check boxes next to the note.
In addition to prioritizing and marking notes, you can use Note Flags to organize your information. The Note Flags Summary Task Pane makes it easy to manage and view all the items you have flagged with Note Flags, which can be viewed by page, by notebook section, or across all notebook sections. Clicking a flagged note in the Note Flags Summary Task Pane takes you to that note in your notebook sections. In this way, you can navigate through notes according to the flags. For example, you could customize a Note Flag as a “supervisor” flag and after a meeting, call up all the action items your supervisor had mentioned. 
Syncing Tasks with Office Outlook 2003 and 2007

Office OneNote 2007 offers two-way synchronization with Office Outlook 2007. For example, you can synchronize flagged tasks between OneNote 2007 and Outlook 2007, so an item flagged as a task in OneNote 2007 automatically appears as a task in Outlook 2007 (and vice versa).
Also, you can link meeting notes to appointments in your Outlook calendar, or you can link a OneNote note about a customer to their item in your Outlook contact list. Later, if you needed to find information about the meeting on your calendar or contact details associated with that customer, you can either click on the link in OneNote 2007, or click the link in your calendar or contacts list in Office Outlook 2007 to access the information saved in Office OneNote 2007.

Exporting Content to other Office Applications

Office OneNote 2007 enables you to move notebook content to other Microsoft Office system applications. For example, you can select a notebook page and can send it to Office Word 2007 by selecting File > Send Page To from the menu bar.
Support for Multiple Computers

You can edit the same notebook on your multiple computers. This is useful when you have:

· A desktop computer and a laptop at work.
· Several computers at home connected to the same home network.
· A home laptop and a work computer (if you can connect your home laptop to your network at work).
Office OneNote 2007 will automatically synchronize the changes among your computers when you are online, even if you made the changes while you were not connected.

To open a notebook on multiple computers, all you need to do is put it in a location that each computer can access. When you create a new notebook, pick the option "I will use it on multiple computers" in the New Notebook Wizard and Office OneNote 2007 will guide you through the process.
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 Figure 20: Selecting for multiple computers in the New Notebook Wizard
To see whether your notebook is up to date, check the button on the toolbar or to go File > /Sync. You can click the button to check the status of each individual notebook.
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Working Together with Others More Effectively

Shared Notebooks

Office OneNote 2007 has extended the concept of sharing beyond the real-time sharing sessions delivered in OneNote 2003. Using Office OneNote 2007 and a Windows SharePoint Services site or a standard file server, you can share entire notebooks that multiple users can work together in at the same time or at different times. 
A team’s shared OneNote notebook can contain a wide variety of content to help them work more efficiently, including:

· Meeting or project notes.
· Project brainstorming ideas.
· Any supporting materials collected by team members.
· Lists of action items.
· Drafts of project reports that team members can annotate.
· Project plans.
· Web research and more.
Shared notebooks are easy to use and enable you to work with other people in the same notebook at the same time—there is no “check-out” or “check-in” required—and Office OneNote 2007 smoothly merges everyone’s changes. On the rare occasions when two people make changes to the same text container at the same time, Office OneNote 2007 displays an alert that synchronization failed and produces both versions for you to view.

Create a Shared Notebook

You can easily create a shared notebook by following these simple steps:

1) In the File menu, select Share.
2) Choose Create Shared Notebook.
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Figure 21: Create a shared notebook
3) A wizard will open and prompt you through the remaining steps.
Invite Others into a Shared Notebook
Office OneNote 2007 makes it easy to invite other people to join a shared notebook by creating an e-mail message that you can use to invite participants. By clicking the link in the body of the e-mail message, the people you have invited can join the shared notebook. 
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Figure 22: Sharing notes with Office OneNote 2007
Offline Access and Synchronization
Team members can work on the shared notebook on their computers, even when they are offline. As soon as they regain network access, OneNote reconciles the local copies of the notebook with the master copy saved on the server and merges any changes into each copy of the shared notebook. This helps ensure that every member of the team has a current copy of the notebook—regardless of where they are or when the new content was added. Everyone remains on the same page, even when the page gets updated.
Password Protection

You can always retain control of your notes by sharing your notebook or sections of your notebook only when you want and with whom you want. For example, you can give some people access to only to certain sections of your notebooks with password protection, and you can revoke access whenever it is appropriate.
Hosting Shared Notebooks 

A OneNote notebook can be shared simply by storing it in a location from which others can also open it, such as a folder share on your own computer, a file server, or a SharePoint site (using Windows SharePoint Services 2.0 or later). Office OneNote 2007 will guide you through setting up a proper location if you use the Share menu or the shared notebook option in the New Notebook Wizard.

Hosting Shared Notebooks on Windows SharePoint Services
Office OneNote 2007 provides an easy way to bring new types of valuable content into a company’s long-term content repository, and Windows SharePoint Services increases the security and value of OneNote notebooks—Windows SharePoint Services helps protect the OneNote notebooks it stores. Also, the content stored in OneNote notebooks becomes searchable as part of the Windows SharePoint Services content repository. This makes new types of content available to the organization, such as indexed images and indexed audio and video recordings.

Live Sharing Sessions in Office OneNote 2007

Another sharing option in Office OneNote 2007 is a Live Sharing Session. This feature enables you to share a page of notes or multiple pages of notes with other users in real-time. Live Sharing Sessions use peer-to-peer technology, so no server infrastructure is required. They are also easy to use and can be set up with just a few clicks of the mouse. You can create or join a Live Sharing Session using the Live Sharing Session option on the Share menu.

You can also use Office OneNote 2007 to broadcast note sessions to other OneNote users, so you can share your notes in real time without giving others the ability to interact with your notes. At the end of a shared session, each user retains a copy of the shared notes as part of his or her notebook, so there is no need to take a record of what was discussed.

The advantage of Live Sharing Sessions is that no server infrastructure is required and you can share your notes and information with others in real time. The disadvantage is that once you terminate a Live Sharing Session, you are no longer sharing your notes with others. Changes you make while outside of a Live Sharing Session do not get updated on other user’s computers. In this regard, Microsoft recommends using Shared Notebooks instead of Live Sharing Sessions when possible.
Other Ways to Share

Sharing Notes Using E-Mail

By clicking the e-mail icon on the Standard toolbar (or using the E-mail Recipient option from the Send Page To command on the File menu), Office OneNote 2007 users working with Outlook 2003 or later can share their note pages with others. Office OneNote 2007 creates a special file consisting of copies of your selected pages and attaches the file to the message. It also automatically formats the information on the page (including graphics
) as HTML code and puts it in the body of the e-mail message, so even recipients who do not have Office OneNote 2007 can read the information. 
If a page has linked audio or video files, Office OneNote 2007 also attaches a copy of these to the message if you have elected to do this by clicking Options on the Tools menu. E-mail message recipients who have OneNote can double-click the attachment and add that page to their own notebooks in a special section called Recent Opened Sections. 

If you are using an older version of Outlook or are using other e-mail programs, you can still send OneNote notes to other e-mail recipients by manually attaching the file containing the selected pages to the message. Neither older versions of Outlook nor other e-mail programs convert the notes on the Office OneNote 2007 page to HTML for inclusion in the body of the message, but you can still copy and paste your notes into your e-mail program.

Publish Notes to a Website or to a Windows SharePoint Services Website

You can easily share information with others in a read-only form, by publishing your notes in single-file Web page form that others can view with a Web browser or open and edit in Word 2007. Using the Publish as PDF or XPS option on the File menu, you can create a copy of your OneNote page in a variety of formats, including a PDF file, a single file Web page, as a separate OneNote section, or as a Microsoft Word 2007 file. You can post the published file on a file share, Web site, or Windows SharePoint Services Web site. You can even send the files to others as an e-mail attachment. Office OneNote 2007 converts handwriting and drawings into pictures when it publishes the page in HTML format.

Export API

A full export application programming interface (API) provides a user-friendly link to business systems. You can reduce errors and avoid entering the same data in multiple systems by connecting Office OneNote 2007 directly to the other systems you use.
Summary

In today’s world of work, people need tools to help them work more efficiently to increase their impact and work more effectively with others.
Office OneNote 2007 is all about gathering, finding, and working with all types of relevant information with others in your company. It helps you capture, organize, and share a wide variety of information types—from text and graphics to images and audio. It provides fast and powerful information search and retrieval capabilities, including the ability to scan images and audio files for searchable text, so you can manage your information more efficiently.

By consolidating all the information you and your team need to do your job in one place, Office OneNote 2007 enables you to work together more easily and efficiently to meet your objectives.
Other Office Enterprise 2007 Programs
For more information on the features in all other Microsoft Office programs included in Microsoft Office Enterprise 2007, please visit www.microsoft.com/office/preview/.
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